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END USER LICENSE AGREEMENT

1. This License Agreement permits Test Engineer to use one copy of the enclosed
software program (the "SOFTWARE") on a single computer. If Test Engineer have a
multi-user license for the SOFTWARE, then at any time Test Engineer may have as
many copies of the SOFTWARE in use as are permitted by the multi-user license. The
SOFTWARE is in "use" on a computer when it is loaded into temporary memory (i.e.,
RAM) or installed into permanent memory (e.g., hard disk, CD-ROM, or other storage
device). If the anticipated number of users of the SOFTWARE could exceed the number
of users permitted by applicable licenses, then Test Engineer must have a reasonable
mechanism or process in place to ensure that the number of persons using the
SOFTWARE does not exceed the number permitted by the applicable licenses. All
rights not expressly granted to Test Engineer in this Agreement are reserved to PACIFIC
POWER SOURCE.

2. COPYRIGHT. The SOFTWARE is owned by PACIFIC POWER SOURCE and is
protected by United States copyright laws and international treaty provisions. Therefore,
Test Engineer must treat the SOFTWARE like any other copyrighted material. Test
Engineer may, however, either (a) make one copy of the SOFTWARE solely for backup
or archival purposes, or (b) transfer the SOFTWARE to a single hard disk, provided Test
Engineer keep the original solely for backup or archival purposes. Test Engineer may
not copy the written materials accompanying the SOFTWARE.

3. OTHER RESTRICTIONS. Test Engineer may not reverse engineer, decompile, or
disassemble the SOFTWARE. Test Engineer may transfer the SOFTWARE to a third
party provided that after each transfer Test Engineer do not retain any copies of the
SOFTWARE, including all upgrades that Test Engineer may have received, nor retain
any of the written materials accompanying the SOFTWARE.

4. OPERATING SYSTEM OPTIONS (CD-ROM MEDIA). If the SOFTWARE is
distributed with multiple versions on a CD-ROM for compatibility with different operating
systems, Test Engineer license grant extends to using only the applicable version for
Test Engineer operating system.

LIMITED WARRANTY

Pacific Power Source warrants, for Test Engineer benefit alone, that (a) the SOFTWARE
will perform substantially in accordance with the accompanying written materials, and (b)
the medium on which the SOFTWARE is recorded will be free from defects in materials
and workmanship under normal use and service for a period of ninety (90) days from the
date of receipt. Some states/jurisdictions do not allow limitations on duration of an
implied warranty, so the above limitation may not apply to Test Engineer.

CUSTOMER REMEDIES

Pacific’s entire liability and Test Engineer sole and exclusive remedy shall be, at
Pacific’s option, either (a)return of the fees paid, or (b) repair or replacement of the
SOFTWARE that does not meet Pacific’s Limited Warranty stated above, and which is
returned to Pacific Power Source. The Limited Warranty is void if failure of the
SOFTWARE has resulted from accident, abuse, or misapplication. Any replacement




SOFTWARE will be warranted for the remainder of the original warranty period or thirty
(30) days, whichever is longer.

NO OTHER WARRANTIES. EXCEPT AS EXPRESSLY SET FORTH ABOVE, THE
SOFTWARE AND THE DOCUMENTATION ARE PROVIDED "AS IS" WITHOUT
WARRANTY OF ANY KIND, AND NO OTHER WARRANTIES, EITHER EXPRESSED
OR IMPLIED, ARE MADE WITH RESPECT TO THE SOFTWARE, INCLUDING BUT
NOT LIMITED TO ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE OR ANY OTHER WARRANTIES THAT MAY ARISE
FROM USAGE OF TRADE OR COURSE OF DEALING. PACIFIC POWER SOURCE
DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS
REGARDING THE USE OF OR THE RESULTS OF THE USE OF THE SOFTWARE OR
THE DOCUMENTATION IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY,
OR OTHERWISE AND DOES NOT WARRANT THAT THE OPERATION OF THE
SOFTWARE WILL BE UNINTERRUPTED OR ERROR FREE. PACIFIC POWER
SOURCE EXPRESSLY DISCLAIMS ANY WARRANTIES NOT STATED HEREIN.

PACIFIC POWER SOURCE ASSUMES NO LIABILITY FOR CONSEQUENTIAL
DAMAGES. THE ENTIRE LIABILITY OF PACIFIC POWER SOURCE AND ITS
DEALERS, DISTRIBUTORS, OFFICERS, DIRECTORS, AGENTS, AND EMPLOYEES
ARE SET FORTH ABOVE. TO THE MAXIMUM EXTENT PERMITTED BY
APPLICABLE LAW, IN NO EVENT SHALL PACIFIC OR ITS SUPPLIERS BE LIABLE
FOR ANY DAMAGES INCLUDING ANY SPECIAL, DIRECT, INDIRECT, INCIDENTAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES, EXPENSES, LOST PROFITS, LOST
SAVINGS, BUSINESS INTERRUPTION, LOST BUSINESS INFORMATION, OR ANY
OTHER DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE
SOFTWARE OR THE DOCUMENTATION EVEN IF PACIFIC HAS BEEN ADVISED OF
THE POSSIBILITY OF SUCH DAMAGES. TEST ENGINEER ACKNOWLEDGE THAT
THE LICENSE FEE REFLECTS THIS ALLOCATION OF RISK. Because some
states/jurisdictions do not allow the exclusion or limitation of liability for consequential or
incidental damages, the above limitation may not apply to Test Engineer.

WARNING

PACIFIC PRODUCTS ARE NOT DESIGNED WITH COMPONENTS AND TESTING
FOR A LEVEL OF RELIABILITY SUITABLE FOR USE IN THE DIAGNOSIS AND
TREATMENT OF HUMANS OR AS CRITICAL COMPONENTS IN ANY LIFE SUPPORT
SYSTEMS WHO'’S FAILURE TO PERFORM CAN REASONABLY BE EXPECTED TO
CAUSE SIGNIFICANT INJURY TO A HUMAN.

RELIABILITY OF OPERATION OF THE SOFTWARE CAN BE IMPAIRED BY
ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO FLUCTUATIONS IN
ELECTRICAL POWER SUPPLY, COMPUTER HARDWARE MALFUNCTIONS,
COMPUTER OPERATING SYSTEM SOFTWARE FITNESS, FITNESS OF
COMPILERS AND DEVELOPMENT SOFTWARE USED TO DEVELOP AN
APPLICATION, INSTALLATION ERRORS, SOFTWARE AND HARDWARE
COMPATIBILITY PROBLEMS, MALFUNCTIONS OR FAILURES OF ELECTRONIC
MONITORING OR CONTROL DEVICES, TRANSIENT FAILURES OF ELECTRONIC
SYSTEMS (HARDWARE AND/OR SOFTWARE), UNANTICIPATED USES OR
MISUSES, OR ERRORS ON THE PART OF THE USER OR APPLICATION
DESIGNER. (ADVERSE FACTORS SUCH AS THESE ARE HEREAFTER
COLLECTIVELY TERMED "SYSTEM FAILURES.")



ANY APPLICATION WHERE A SYSTEM FAILURE WOULD CREATE A RISK OF
HARM TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY
AND DEATH) SHOULD NOT BE RELIANT SOLELY UPON ELECTRONIC
MONITORING DUE TO THE RISK OF SYSTEM FAILURE. TO AVOID DAMAGE,
INJURY OR DEATH, THE USER OR APPLICATION DESIGNER MUST TAKE
REASONABLY PRUDENT STEPS TO PROTECT AGAINST SYSTEM FAILURES,
INCLUDING BUT NOT LIMITED TO BACK-UP OR SHUT DOWN MECHANISMS.

WARNING

THIS AGREEMENT IS GOVERNED BY THE LAWS OF THE STATE OF CALIFORNIA,
EXCLUSIVE OF ANY PROVISIONS OF THE UNITED NATIONS CONVENTION ON
THE INTERNATIONAL SALE OF GOODS, AND WITHOUT REGARD TO PRINCIPLES
OF CONFLICTS OF LAW, AND CONSTITUTES THE COMPLETE AGREEMENT
BETWEEN TEST ENGINEER AND PACIFIC POWER SOURCE. IT SUPERSEDES
ANY ORAL OR WRITTEN PROPOSALS, PRIOR AGREEMENTS, PURCHASE
ORDERS OR ANY OTHER COMMUNICATION BETWEEN TEST ENGINEER AND
PACIFIC POWER SOURCE RELATING TO THE SUBJECT MATTER OF THIS
AGREEMENT. If any action is brought by either party to this Agreement against the
other regarding the subject matter hereof, the prevailing party shall be entitled to
recover, in addition to any relief granted, reasonable attorney fees and court costs. If
any provision of this Agreement is held invalid, the offending clause will be modified so
as to be enforceable and, as modified, shall be fully enforced, and the remainder of this
Agreement will continue in full force and effect.

Contractor/manufacturer is Pacific Power Source, Inc., 17692 Fitch, Irvine, CA. 92614
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OVERVIEW

Test Manager is a unique UPC Studio feature that consolidates all UPC Manager
features into a single comprehensive test executive. Test Manager allows test
engineer to link together a series of Test Sequences and custom reports into a
single Test Plan. Test Manager also allows test engineer to quickly create and
run a Test Sequence using multiple Output Sequences and control steps such as
Timers, User Prompt and Metering functions.

UPC STUDIO Test Manager Map

4[ UPC MANAGER ]—

1 \ 4 \ 4 \ 4 \ 4

Test UPC UPC WRITE READ
Manager SETTINGS SETTINGS
STUDIO CONTRO TO UPC TO UPC
v v
Output

.Prra!: Se:s::‘ce Sequ:nce

(Nx) (Nx)

Timer Transient Steady State
User Input User Prompt
Control Meter
Script VISA

e Test Plans: A collection of Test Sequences.

e Test Sequences: A collection of Output Sequences and various control steps.

¢ Output Sequences: A collection of steady state outputs, waveforms and
associated transients.




1. Overview ( Cont.)

Test Manager features:

e Automate instrument compliance testing and certification. Obtain pre-
configured test sequences from Pacific Power Source for a variety of
standard and custom applications.

e Custom report generation, printing and print preview. Create report
templates using MS Word with page header/footer, page paragraph and
character formatting, graphics and form fields.

e Test reports fully document and record parameters and results for each
test step. Built-in error handling helps isolate the root cause of failures

e Built-in editor allows test engineers to create and run their own custom
test sequences and test plans.

e Within a Test Sequence, run an entire test or control test flow using Single
Step, Run-To-Next, Run Selected, Stop or Resume. Disable individual
steps for troubleshooting, reconfiguring, prototyping and debugging.

e No compiling needed. Run entire tests or individual steps immediately
after making changes.

e Test sequences support 8 built-in test step types including Steady State
Output, Transient Trigger, UPC Control, User Prompt, User Input, Timer,
VISA (generic instrument control) and UPC Metering.

e Embed Scripts to create custom functions with full access to test manager
objects.

e Complete UPC metering support including waveform capture and
V/I/F/Power/Harmonics. Specify measurement functions and phases,
value limits, out-of-limit behavior and data logging.

e Total, elapsed and remaining time indicators for the entire test and
individual steps. Monitor the progress and results of each step while the
test runs.

Pacific Power Source has developed several test sequences based on common
industry test standards. These test sequences can help test engineers to simplify
test procedures in their compliance testing practice, and are offered as cost
options which can only be used with UPC Studio Test Manager. Please contact
Pacific Power Source sales representative for more information either by
phone:+1.949.251.1800 (worldwide), and 1.800.854.2433 (US only) or
email:sales@pacificpower.com.
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GETTING STARTED

Test
Manager
v
Test Output
Sequence Sequence
(Nx) . (Nx) .
Timer Transient Steady
State
Script VISA

All UPC Manager features operate in “Simulate” mode. Test engineer may open,
create and edit Test Plans and Test Sequences without restriction. However, to
communicate with a Pacific Power Source product, a registration number, which
is unique to the power source in user, must be obtained from Pacific Power
Source. Test Manager is installed on the computer as part of UPC Studio during
UPC Manager installation. Test engineer can experience the capabilities of UPC
Studio Test Manager in “Simulate” mode. To activate UPC Studio Test Manager
to communicate with power source unit, administrator is required to obtain a UPC
Studio Test Manager registration code from Pacific Power Source for each serial
number associated with the power source unit. The contact information is phone:
+1.949.251.1800 or 1.800.854.2433 (US only); email:sales@pacificpower.com.
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2. Getting Started ( Cont.)
To register UPC Test Manager,

e Launch UPC Manager from the desktop quick launch icon or

click Start > Programs - Pacific Power Source - UPC Manager
from the desktop to open the UPC Manager window

e Click Help >Registration to open the Enter Registration Code
window.

e Click Help =>Registration to open the Enter Registration Code
window



2. Getting Started ( Cont.)
To open UPC Test Manager:

e Click a tab to select GPIB, Serial or Simulate mode in the UPC
Studio Setup window as shown below.

Note: In “Simulate” mode, 133xxx emulates a UPC12 or UPC32
controller; 141xxx emulates a UPC1 or UPCS3 controller.



2. Getting Started ( Cont.)

e Click Connect to open the UPC studio window as shown below.
UPC Studio window is displayed, showing the present operating condition.

The Test Manager button in the main UPC Studio window allows user to open
an existing test sequence or test plan. The drop down menu also lets user create
a new test sequence or test plan file and contains a list of available files located
in the test manager folder (typically "C:\Pacific Power Source\UPC Manager\Test
Manager") on the PC. Selecting one of these items opens that file.

Open,.. Test Sequence

MIL-3TD-704D r

Files and falders in Test Plugins »
bl anager folder Basic.bpl

Cwverload Test.bsg

Note: .tpl: Test Plan file type.
.tsqg: Test Sequence file type.



3
INTRODUCING TEST PLAN WINDOW

Test
Manager
\ 4
Test Output
Sequence Sequence
(Nx) . (Nx) .
Timer Transient Steady
State
Script VISA

A Test Plan is a collection of test sequences. Test plans manage and simplify
complex tasks by allowing test engineer to link together a series of test
sequences into a single file. Test sequences consist of one or more test steps
designed to run a test, automate a task, or control and monitor the power source
or other instruments. The results of a test sequence and test plan are stored in a
test report which is automatically generated in UPC Test Manager.



3 Test Plan Window ( Cont.)

When test engineer open an existing test plan file or create a new one using the
Test Manager button in the UPC Studio window, the Test Plan window appears
as shown below.

Interface Connection File Name

File Menu
and Toolbar

Title Bar

Tabs

Context Area

Context

Time and Progress Indicators Menu

Run State

Run Toolbar

Step Table

Event Status Panel



3.1 File Menu and Toolbar

The file menu and MDI ( Multiple Document Interface ) toolbar (shown below)
allow test engineer to create a New test plan, Open an existing file, Save or
Save As... (To a different file) or Revert the test plan to the last saved version.
The Save and Revert items are only enabled if the test plan has been edited but
not yet saved (the file name in the title bar shows an "*" at the end).

O = H o=

Plewy S | ‘ ‘

Qpen. ..

Save

Sawve As...
Rewert

Exik

3.2 Title Bar

The title bar shows the interface used to connect to a UPC and the test plan file
name. An "*" at the end means the file is currently being edited and the changes
have not been saved.

3.3 Objective Tab, Context Area and Context Menu

Selecting one of the tabs updates the Context Area with that item. In the
previous example, the Objective tab is selected. The objective is intended as a
brief summary or description of the test plan and will be automatically included in
the test report. Test engineer can type directly into the context area or copy and
paste text or graphics from another application. Right-clicking the context area
displays the Context Menu. Test engineer can Load or Save the objective from
a Rich Text (*.rtf) or Plain Text (*.txt) file. Go-to... shows the current cursor
location and allows test engineer to position the cursor to a particular line and
column.



3.4 Preferences Tab

The Preferences tab shown below displays general settings and file information
for the test plan.

Preferences l

Pratect File — v Allow Edit  Pazswoard:

File Info _{ File Path: C:\Wizual B azic Projectsh\UPC Settings\T est Manager.Sample Plan.tpl
Last Updated: 07/25/2007 17:56:36
Feport Template — Repart Template: | anual <Blank: |

Test engineer can protect a test plan from inadvertent changes by un-checking
the Allow Edit checkbox. For additional security, test engineer can assign a
Password. Once a password is assigned, test engineer will be prompted to enter
it in order to allow editing. The File Info section shows the full path of the test
plan database file and the last time it was updated.

The Report Template shows which template is used by all test sequences in this
test plan. This is useful if the test sequences update form fields in the report or
test engineer want the test plan to always use a particular template. If this item is
red, that template file is missing from the Templates folder (typically "C:\Pacific
Power Source\UPC Manager\Test Reports\Templates"). Pressing the Load
button initializes the report with that template (if it's not already loaded). Clicking
in the report template text box displays a drop-down list of template files installed
on the computer that test engineer can select. The "Manual" selection means the
test sequences use whatever template file is currently loaded. An "*" means the
test report has been updated and changes have not yet been saved.

Note: The test plan report template overrides the report templates
specified in the test sequences.

10



3.5 Step Objective Tab

The step objective is intended as a brief summary or description of the selected
test sequence included in the test plan. If the objective is defined during the test
sequence creation, the step objective is automatically loaded in Step Objective
window when the test sequence is added.

3.6 Step Info

The Step Info tab illustrated below shows the full path of the selected test
sequence database file and the last time it was updated. Test plans only contain
references to test sequence files, not the actual file contents. Test plans maintain
"relative” path relationships with test sequence files. This allows the test plan and
test sequence files to be moved to a different location or PC, as long as the files
retain the same location relative to each other.

11



3.7 Step Result Tab

Step Result tab illustrated below relates to the selected step and it shows the
result icon and title (Passed, Failed, Stopped, and Skipped), date/time the step
completed and the elapsed time the step completed from the beginning of the
test. If a step fails, the results also include the error description.

3.8 Run State

The Run State section above the Run Toolbar shows the current status of the
test. The various run states are shown below.

Idle
Running Step n...

Stopped

Failed

Done

No test or steps have completed or are currently running.

Step "n" is currently running.

The test was stopped. The results column in the step table
shows which step was stopped. A test is stopped by pressing
the Stop button in the run toolbar or the Stop button in a User
Prompt, User Input or Transient Prompt dialog box.

The test failed. The results column in the step table shows which
step failed. Click in the results column for that step to view
additional information.

The test or selected step(s) have successfully completed.

12



3.9 Run Toolbar

The table below describes the buttons in the Run Toolbar. Some items (like Run
Step) require one or more selected rows in the step table. Running a step runs
the entire test sequence for that step. To run an individual step in a test
sequence, open the test sequence file (double-click it in the test plan step table),
then use the run toolbar in the test sequence window.

Start - Clears the test report then runs the entire test starting from step 1
(regardless of which step is currently selected).

Continue - Resumes the test starting with the currently selected row (step).
The test continues to the last step.

Run Step- Runs the selected step(s) then pauses. Run Step is convenient
for testing and troubleshooting.

Run To Next- Runs the selected step. When the step completes, the test
pauses with the next row selected. Run To Next allows test engineer to
"single step" through a test sequence.

v

I+

i

g Show Running Step- When a test is running, pressing this button selects
and shows the currently running step, scrolling the step table if necessary.

5117 Stop - Stops the test and disables the power source output.
£ Show Report - Shows the test report window

Running a test using Start, first initializes the test report, then appends the test
data to the report after each step completes. This creates a clean test report
each time the test is run. Running a test using the other controls does not first
clear the test report, making it easier to troubleshoot (single step etc) a test.

3.10 Time and Progress Indicators

The upper time and progress indicator shows the values for the entire test (all
enabled steps) and the lower one shows the values of the selected step(s). The
total time values update as step rows are selected making it easy to see when
that step begins relative to the start of the test, even if a test is not running. The
total time values take into account if step rows are not enabled (step checkbox
not checked). Time and progress indicators are updated as the test runs. Step
times are estimates based on the test sequence and system performance. Time
values are shown in HH:MM: SS.SSSS format. The actual elapsed time of each
step is recorded in the test report.

13



3.11 Event Status Panel

Event Status Panel in the Test Plan window functions the same in the Test
Sequence window. It consists of Execution State icon and Executing Program /
Output Sequence description. Different colors of the Execution State icon
indicates different types of state being currently executed such as steady state,
transient state, ramp or no program. Executing Program is the program number
(or Manual Mode) of the currently executing program. The program number
range for execution is defined in the Preference tab when the test sequence is
created. Manual Mode is automatically entered whenever an output parameter of
the last executing program was changed. If the program is based on an output
sequence, the output sequence file name is also shown.

3.12 Test Plan Step Table

The step table shown below appears at the bottom of the Test Plan window. The
steps in the table are links to test sequence files stored in the Test Manager
folder (Typically "C:\Pacific Power Source\UPC Manager\Test Manager").
Double-clicking one of the test sequence files in the table opens the test
sequence window, allowing test engineer to view or edit the values.

e Right-click anywhere in the step table to active step context menu shown

below.
Add...
Zuk k2
Copy Zhrl+C
Paste Chrl+Y
Delete DEL
Select Al Chrl+4

Zlear Resulks

14



3.12 Test Plan Step Table ( Cont.)

Add...
Cut

Copy

Paste

Delete

Select All
Clear Results

Displays a file open dialog box. The test sequence file
Test engineer select is added to the table.

Copies the selected steps to the clipboard and then
deletes them from the table.

Copies the selected steps to the clipboard.

Pastes the clipboard after the selected step.

Deletes selected steps.

Selects all steps.

Clears the results column of the selected steps.

Note: If no step is selected before user right-clicking the step table, Cut,
Copy, Delete and Clear Results selection will be disabled.

3.12.1 Step Table Columns

The columns in the step table are described below.

Step

Test Sequence

Steps

Time

Results

Enables checkbox and step number. Steps that aren't
checked are skipped when the test sequence runs.
Un-checking a step is a convenient way to temporarily
disable a step while troubleshooting or reconfiguring a
test.

Shows the File Status Icon and test sequence file
name. Refer to the test sequence file status section
below for more information.

Indicates total number of steps in the test sequence.
Numbers in /talic mean the test sequence contains
one or more disabled steps.

Estimates to run the test sequence.

Shows the results state (Pass, Fail, Stopped, and
Skipped) the last time this step was run. It also shows
if a step is currently running. Clicking in the results
column for a particular step automatically selects the
Step Result tab in the test plan window, providing
additional information.

15



3.12.2 Test Sequence File Status

The test sequence file status is shown in the Test Sequence column of the step
table. The table below shows the status of various conditions.

S ample Test tg The test sequence file exists but is currently not loaded.

<l Sample Testtsy ~ The test sequence file is currently loaded. Test sequence files are
automatically loaded when they are run or opened (double-click).

< Sampl= Testtsg*  The test sequence file is loaded and currently being edited (*).

> Sample Testisa  The test sequence file is missing. Use the Step Info tab in the main test
plan window to view the file path the test plan expects.

< Sample Testtsg  The test sequence contains invalid values or values not supported by
the power source in use. Double-click the file to view or edit the values
(opens test sequence window). Note that the test plan only checks for
invalid or unsupported values when the test sequence loads or runs.

16



CREATING AND VIEWING
TEST REPORT

The Test Report window allows test engineer to view and print test reports
created by a test sequence or test plan.

To access the test report window:
e Click the Report icon in the Run Toolbar in the Test Plan or Test

Sequence window to open the Test Report printout window as shown
below.

Idle

Start lcon —|p |§| @ ¥ Report icon in Run Toalbar
[

Test Sequence or Test Plan Run Toolbar

A sample test report is shown below, initialized from a template file.

17



4 Creating and Viewing Test Report ( Cont.)

The top of the test report window includes a File menu and toolbar as illustrated
below.

™ upc Manager v1.2

File Window Help Blanl.a.
Cpen... Zertificate
[7 |- = ﬁ % Engineeting Eval
Blank. Save fis... v Template Sample
Certificate
Engineering Eval v Page Lavout
v Template Sample Page Parameters. .,
Print Sefup...
Print Presview
Prink, ..
Exit

The New item allows test engineer select one of the template files stored in the
Test Report template folder (typically "C:\Pacific Power Source\UPC
Manager\Test Reports\Templates”). Selecting a new template file or pressing the
New button creates a new test report based on the selected template file.

A template file is a .RTF file created in MS Word and is used as a test report
template to store test result during a Test Plan or Test Sequence execution.
Template files can be blank or contain introductory text, graphics, page header
and footer (page numbering, date etc), page/paragraph/character formatting,
form fields. Each form field should be given a unique field name. When a report
template file is loaded in a Test Plan or Test Sequence, the form field names
embedded in the template file will be available to Report Field in User Input step
(See Chapter 6.4 User Input). Test engineer can select the form field names from
the Report Field to store input information in a test report. Refer to Chapter 7
Exercise for examples on creating template files and working with template files
in Test Sequence or Test Plan.

18



4.1 Test Results

Running a test sequence or test plan appends the results of each step at the end
of test report. Running a test sequence from the beginning (using the Start icon
in the Run Toolbar) initializes the test report from the selected template file then
adds the test sequence Objective and Preferences. This creates a clean report
each time the test sequence is run. Running a test sequence using the other
controls does not clear the test report or add the Objective or Preferences,
making it easier to troubleshoot (single step etc) a test.

After each step runs, the information about that step is appended to the test
report as shown below. This information includes the Title, Value, Comment,
Result and Data of each step.

Title Step 2 -~ Meter [Sample Test]
Type: V. I.F.Power Form: 3 [f Dutzide Limitz: Fail Samplez: 1 Interval: 1.0 zec
Phaze Vims Irms
A Yz ez
120500 «<=25.000
»119.500
Value B ez ez
¢ 120500 «<=25.000
»119.500
C ez ez
¢ 120600  «<=25.000
»119.500
Comment Comment Check Valtz and Amps
Result QPEISSE[! - 0742572007 14:51:18 [Elapsed Time HH:MM:55 = 00:00:01.9414]
Phaze  Yims[L-M] Irms
Data A 120.000 0.000
] 120.000 0.000
C 120.000 0.000

Title: Includes the enable checkbox, step number, icon, type and test sequence
file name.

Value and Comment: Are the test sequence information from the design
window, Step Value/ Comment tab.

Result: Shows the result icon, title, date/time the step completed and the
elapsed time the step completed from the beginning of the test.

Note: Not all steps produce data. The data also includes any errors that

occurred running the step. Result and Data are also shown in the
Step Result tab in the test sequence window.
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4.2 Test Plan Step Title

When a test sequence is part of a test plan, the step Title in the test report
shows both the test plan and test sequence step humbers and file names.

Test Plan Step Number Test Flan File Name

- |
Step 1.2 -~ Meter [Sample Plan] [Sample Test]

Tezt Sequence Step Nurmber Tezt Sequence File Mame

4.3 Controlling Report Information

UPC Test Manager allows test engineer to create a script with the
TM.StepReportFlags method (see Chapter 6.8 Script) to control the step items
included in the test report for any step. These step items include but are not
limited to: step comment, step summary and step title. The default setting for
test report generation is to include all information (Title, Value, Comment, Result
and Data)
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INTRODUCING TEST
SEQUENCE WINDOW

A Test Sequence is a collection of Output Sequences and various control
steps. Test sequences consist of one or more test steps designed to run a test,
automate a task, or control and monitor the power source or other instruments.
The results of a test sequence are stored in a test report.

A test sequence file contains all the information necessary to run the test. This
makes it easy to transfer the test sequence to another location or PC. When Test
Engineer open an existing test sequence file or create a new one using the Test

Manager Button in the UPC Studio window, the test sequence window appears
as shown.

Interface Connection File Name

File Menu
and Toolbar

Title Bar

Tabs

Context Area

Context
Menu

Run State

Run Toolbar

Step Table

Event Status Panel
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5.1 File Menu and Toolbar

The file menu and MDI toolbar allows user to create a new test sequence, open
an existing file, Save or Save as... (to a different file) or Revert the test
sequence to the last saved version. The Save and Revert items are only enabled
if the test sequence has been edited but not yet saved (the file name in the title

bar shows an "*" at the end).
I~

5.2 Title Bar

The title bar shows the interface used to connect to the UPC and the test
sequence file name. An "*" at the end means the file is currently being edited and
the changes have not been saved. If the test sequence is part of a test plan, the
test plan file name is shown first.

Test Plan File M ame

WEEEES ¥ Test Sequence - SIM::141517_v500 - Sample Plan.tpl - Sample Test.tsq®

Test Sequence File Mame

5.3 Objective Tab, Context Area and Context Menu

Selecting one of the tabs updates the Context Area with that item. In the above
example, the Objective tab is selected. The objective is intended as a brief
summary or description of the test sequence and is automatically included in the
test report. A user can type directly into the context area or copy and paste text
or graphics from another application. Right-clicking the context area displays the
Context Menu. User can Load or Save the objective from a Rich Text (*.rtf) or
Plain Text (*.txt) file. Go-to... shows the current cursor location and allows test
engineer to position the cursor to a particular line and column.
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5.4 Preferences Tab

The Preferences tab shown below displays general settings and file information
for the test sequence.

Freferences I

Pratect File — v Allow Edit  Passwaord:

File Path: C:%Wisual B asic ProjectshJPC SettingzhTest Managerhs ample Test tzq

File: Inf
" st Updated: D7/20/2007 06:58:26 | Report Template
Program List — Usze Programs: |E!D-SE| Report Template: | Fiadinata Load
Limit Value Range ¥ Lock Frequency Span IPC-143 Orly
. Frequency Min 15.00
Limits T able — 18.00-1200.00 H
i 1an Frequency hiax 1200.00 ‘
Yoltage Min n.an

0.00-600.00'Y
VokageMax  500.00 e

test engineer can protect a test sequence from inadvertent changes by un-
checking the Allow Edit checkbox. For additional security, Test Engineer can
assign a Password. Once a password is assigned, Test Engineer will be
prompted to enter it in order to allow editing. The File Info section shows the full
path of the test sequences database file and the last time it was updated. The
program list defines which stored programs in Test Engineer UPC the test
sequence can use. These programs will be overwritten as necessary when
running the test sequence. The program list can be a range (90-99), comma
separated values (90, 93, 97) or both (90-93, 99). The Limits Table lets Test
Engineer to define the minimum and maximum frequency and voltage values
allowable during the test. The test sequence will not run any program step
(steady state or transient) that contain values outside these limits.

The Report Template shows which template is used with this test sequence. This
is useful if the test sequence updates form fields in the report or Test Engineer
want the test sequence to always use a particular template. If this item is red,
that template file is missing from the Templates folder (typically "C:\Pacific Power
Source\UPC Manager\Test Reports\Templates”). Pressing the Load button
initializes the report with that template (if it's not already loaded). Clicking the
report template text box displays a drop-down list of template files installed on
Test Engineerr computer that Test Engineer can select. The "Manual" selection
means the test sequence uses whatever template file is currently loaded. An "*"
means the test report has been updated and changes have not yet been saved.
Note: If the test sequence is opened from a test plan, the test plan report
template is used.

23



If the Lock Frequency Span checkbox is checked, the highest frequency in the
test sequence is used when setting the frequency span. This prevents the
frequency span from changing and leaves the output enabled during the test. If
this checkbox is not checked, the optimal (lowest) frequency span is selected for
each step. This provides the maximum output waveform resolution and greatest
metering accuracy but may cause the output to be temporarily disabled as the
test runs. This checkbox is only available for UPC-1/3 based power sources

5.5 Step Value/Comment Tab

Step Value/Comment Tabs allows user to edit settings and comment for each
selected step in the Step Table. The content in the tab varies depending on the
type of test steps selected. The text Test Engineer enter in the Comment box
automatically appears in the step table and test report.
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5.6 Step Result

Result Tabs records

the test result for each select step and additional desired

information. The results can be recorded in the forms of text, numbers or graphs

defined by users.

5.7 Run State

The Run State secti
test. The various run

Idle
Running Step n...

Stopped

Failed

Done

on above the Run Toolbar shows the current status of the
states are shown below.

No test or steps have completed or are currently running.
Step "n" is currently running.

The test was stopped. The results column in the step table shows
which step was stopped. A test is stopped by pressing the Stop
button in the run toolbar or the Stop button in a User Prompt,
User Input or Transient Prompt dialog box.

The test failed. The results column in the step table shows which
step failed. Click in the results column for that step to view
additional information.

The test or selected step(s) have successfully completed.
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5.8 Run Toolbar

The table below describes the buttons in the Run Toolbar. Some items (like Run
Step) require one or more selected rows in the step table.

Start - Clears the test report then runs the entire test starting from step
13 1(regardless of which step is currently selected).

Continue - Resumes the test starting with the currently selected row
(step). The test continues to the last step.

Run Step- Runs the selected step(s) then pauses. Run Step is convenient

i+

for testing and troubleshooting.

Run To Next- Runs the selected step. When the step completes, the test

pauses with the next row selected. Run To Next allows Test Engineer to
"single step"” through a test sequence.

Show Running Step- When a test is running, pressing this button selects
> and shows the currently running step, scrolling the step table if necessary.
5107 Stop - Stops the test and disables the power source output.
¥  Show Report - Shows the test report window

Running a test using Start first initializes the test report then appends the test
data to the report after each step completes. This creates a clean test report
each time the test is run. Running a test using the other controls does not first
clear the test report, making it easier to troubleshoot (single step etc) a test.

5.9 Time and Progress Indicators

The upper time and progress indicator shows the values for the entire test (all
enabled steps) and the lower one shows the values of the selected step(s). The
total time values update as step rows are selected making it easy to see when
that step begins relative to the start of the test, even if a test is not running. The
total time values take into account if step rows are not enabled (step checkbox
not checked). Time and progress indicators are updated as the test runs. Step
times are estimates based on the type of step, programmed values and system
performance. Time values are shown in HH:MM: SS.SSSS format. The actual
elapsed time of each step is recorded in the test report.
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5.10 Event Status Panel

Event Status Panel consists of Execution State icon and Executing Program /
Output Sequence description.

L= Manual Mode :|

Execution State Ewecuting Program,
Output Sequence

Different colors of the Execution State icon indicates different types of state being
currently executed

b

B

This icon means the steady state portion of the executing program
listed is executing.

This icon means the transient portion of the executing program listed
is executing.

This icon means a Ramp is currently executing. Ramps provide a
smooth transition when changing an output parameter (like volts or
frequency) or when executing a new program. Test Engineer can
view or program the Ramp time using the Adjust window.

This icon means no programs are executing. Thisis most likely
caused by an illegal program parameter that would prevent it from
being executed.

Executing program is the program number (or Manual Mode) of the currently
executing program. In the Preference tab user can specify which program to
execute. Manual Mode is automatically entered whenever an output
parameter of the last executing program was changed. If the program is
based on an output sequence, the output sequence file name is also shown.

27



5.11 Step Table

The step table shown below appears at the bottom half of the Test Sequence
window. The table consists of 5 columns- Step, Description, Value, Comment
and Result which are described belwo. The type and order of steps in the table
defines the operations performed by the test sequence.

Step D ezcription Yalue Comment Result
1 Uszer [nput Technician,work Order, Repair Get Info
2 D" Steady State Wa=121.0%b=121.0%c=121.0 F=60.0 Apply nominal voltage
3 ik Timer 0000.00:10 Allow UUT ta seftle
4 ’\ tdeter Wrme lims Check Yoltz and Ampz
b E‘"'::'-i’ Tranzient 3.0 zec Trigger Overvaltage
EjVIS.-’-\ GPIB:1:INSTR Qe UUT Status
T E_L. Contral Output Enable Turn off powwer

Step enables checkbox and step number. Steps that aren't
checked are skipped when the test sequence runs. Un-
checking a step is a convenient way to temporarily disable a
step while troubleshooting or reconfiguring a test.

Step icon and name. Note that Transient steps are linked to a
particular Steady State step. The description column for all
steps up to and including the transient step is automatically
indented.

Shows a brief one-line summary of the values in the step.
Clicking in the Value column for a particular step automatically
selects the Step Value/Comment tab in the test sequence
window, allowing Test Engineer to edit the value.

Shows the step comment. Clicking in the comments column for
a particular step automatically selects the Step Value/Comment
tab in the test sequence window, allowing Test Engineer to edit
the comment.

Shows the results state (Pass, Fail, Stopped, and Skipped) the
last time this step was run. It also shows if a step is currently

Result running. Clicking in the results column for a particular step
automatically selects the Result tab in the test sequence
window, providing additional information.

Step

Description

Value

Comment
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5.11 Step Table ( Cont.)

e Right-click anywhere in the step table, and select New
The step context menu appears as shown below.

Transient
Irnpork. .. Tirner
Export... User Prompk
User Input
Meter

Cuk Chrl+K

Copy CErl4+C control
Paske ey V;:!Sr:qro
Delete DEL
Select al Chrl+A seript
Clear Resulks
New Adds a new step in the step table.
Import Loads a step from a file. User can load Output Sequence files

(*.fm1, *.fm2, *.fm3) or test step files (*.tsp). Output sequence files
contain Steady State and optional Transient values. If both are
present, two steps are added after importing an output sequence.

Export Saves the selected step to a file. When used with Import..., this is
convenient for transferring steps from one test sequence to
another.

Cut Copies the selected steps to the clipboard and then deletes them

from the table.

Copy Copies the selected steps to the clipboard.
Paste Pastes the clipboard after the selected step
Delete Deletes selected steps.

Select All Selects all steps.

Clear Results Clears the results column of the selected steps.

The menu items apply to the currently selected step(s). New steps are added or
pasted after the selected step.

To add or create a step after a selected step:
e Right-click anywhere in the step table, and select New

e Select any desired step type from 8 step types such as Transient, Timer,
or Control

29



Note: If non existing step is selected from the table, a new step is added as
the last step in the table.

To insert a step before the first step in an existing step table:
¢ Right-click table header of a column in the step table, and select New

e Select any desired step type from 8 step types such as Transient, Timer,
or Control
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6
STEP TYPES

There are 8 step types user can choose from to create a test sequence. Users
can setup parameters for each step type under the Step Value Comment tab.

6.1 Transient

The Transient step allows a test sequence to vary the power source output
voltage, frequency and waveform at precisely defined intervals. Use New-
>Transient in the step table context menu to add a transient step to the step
table. Transients are defined in output sequences. Refer to the Steady State step
for instructions on importing output sequences into a test sequence.

Output sequences contain steady state and optional transient values. These
appear as two separate rows in the Step Table linked together. Selecting the
transient step shows the values in the Context Area. Red text indicates values
outside the limits defined in the Preferences tab or values not supported by Test
Engineerr power source. Click the Preferences tab to view and edit the limits.
Note that the limits apply to all Steady State and Transient steps in the test
sequence. Test Engineer can delete the transient step if Test Engineer only want
the steady state values to be used in the test.

The test sequence will not run steps that contain invalid values. When running a
transient step, the test sequence stores the output sequence in one of the
programs Test Engineer specified in the program list in the Preferences tab. It
then enables the output then triggers the transient. When the transient
completes, the power source returns to the steady state values. Pressing the
Stop Button disables the output, stops the transient then return the power source
to the steady state values. Since running a transient step is simply triggering the
transient portion of the output sequence, Test Engineer can add as many
transient steps as Test Engineer want. Test Engineer can also add other step
types (Meter, User Prompt, Timer, etc) between the steady state and transient
steps.
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Dbiectivel Preferences  Step ¥alue/Comment } Step Hesult]

6.1 Transient (Cont.)

To edit the transient values, double click the steady state or transient step in the
step table. The output sequence window will appear allowing Test Engineer to
make changes. Click the Save button in the output sequence window toolbar to
save the changes to the test sequence. Test sequences store the actual contents
of the output sequence Test Engineer imported. This means changes to the
Steady State or Transient steps in the test sequence do not affect the original
output sequence file.

The Context Menu allows Test Engineer to save the transient values to a Rich
Text (*.rtf) or Plain Text (*.txt) file. The text Test Engineer enter in the Comment
box automatically appears in the step table and test report.

The time estimate in the progress/time indicator and step table value column is
based on the transient time.

’7 biry - b aw Time Limnit

Step 2 - |> Transient Time Limit; 235 - 417
Type: Time Ewvent Time: 1.0 zec Ewents: Infinite  Total Time: Infinite [23.5 - 4:17.0] Segments: 2+CR
Segment Frequency ¥a ¥b ¥ Waveform A Waveform B Waveform C  Duration
55 BO.000000  120.000000%  120.000000%  120.000000%  1-Sine 1-5ine 1-5ine
1 B0.000000  135.000000%  135.000000%  135.000000%  1-Sine 1-5ine 1-Sine 0.500000 Sec
2 B0.000000  120.000000%  120.000000%  120.000000%  1-Sine 1-5ine 1-5ine 0.500000 Sec
CR B0.000000  120.000000%  120.000000%  120.000000%  1-Sine 1-5ine 1-Sine 0.000000 Sec

Tranzient Prompt Meszage

Comment; |Dvewa|tage Surge - Wait for min ime then check UUT.

Idle Step Taotal Elapsed Hemaining
2ol 0004170000 0000000000 00:04:17.0000
| e & CF 2 00:0417.0000  00:00:00.0000  00:04:17.0000
Step Descrption Yalue Comment Result
1 D‘ Steady State Wa=120.0%b=1200%c=120.0 F=60.0 Apply nominal voltage
2 Tranzient Infinte [23.5- 4170) ————  Overvoltage Surge - Wait for min time then...

Time Eztimate
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6.1.1 Infinite Transient

The output sequence window allows Test Engineer to specify an infinite number
of events for a transient. Since the total transient time is the event time multiplied
by the number of events, this means the total transient time is infinite. Infinite
transients are useful if Test Engineer need to precisely vary the power source
output over an extended period of time. However, using an infinite transient in a
test sequence would prevent the test from proceeding past the transient. The
only way to cancel it is to press the stop button in the Run Toolbar.

The transient step allows Test Engineer to override an infinite transient by
specifying an optional Min Time and Max Time Test Engineer want the transient
to run. Shown below is an infinite transient step with a min and max time limit.
The time values are in HH:MM: SS.SSSS format. The estimate shown in the
progress/time indicator and step table value column is based on the max time.

ki - b ax Tirne Limit

Dbiectivel Preferences  Step Yalue/Comment l Step He&ultl

Step 2 - | Transient Time Limit: [23.5 - 4:17
Type: Time Ewvent Tirme: 1.0 zec Ewventz: Infinite  Total Time: Infinite [22.5 - 4:17.0] Seaments: 2+CH
Segment Frequency ¥Ya ¥hb Yo Waveform A Waveform B Waveform C  Duration
55 G0.000000  120000000%  120,000000%  120.000000%  1-Sine 1-Sine 1-Sine
1 B0.000000  135.000000%  135.000000%  135.000000%  1-Sine 1-Sine 1-Sine 0.500000 Sec
2 E0.000000  120.000000%  120.000000%  120.000000%  1-Sine 1-Sine 1-5ine 0.500000 Sec
CR B0.000000  120000000%  120,000000%  120.000000%  1-Sine 1-Sine 1-Sine 0000000 Sec

Tranzient Prompt Mezzage

Comment; |Dvewaltage Surge - Wait for min time then check JUJT.

Idle Step Total Elapsed Remaining
2af 20 00:04:17 0000 00:00:00.0000  00:04:17 0000
| ES @ | ¥ 20 00:04:17.0000  O0:00:00.0000  00:04:17.0000
Step Descnphion Yalue Comment Result
1 D‘ Steady State Wa=120.0b=120.0"e=120.0 F=60.0 Apply nominal valtage
2 E"":'-f’ Trangient Infinite [23.5 - 4:17.0) ———— Overvoltage Surge - W ait far mik time then,.

Time E stimate
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6.1.1 Infinite Transient ( Cont.)

When an infinite transient is running, the Transient Prompt window appears as
shown below.

Step Mumber Test Sequence Mame

# Step 2 - Transient [Sample Test]

\?/ Overvoltage Surge - Wait for min time then check —f— Transient Prompt

UuT Meszane
Tranzient Time [HH:kMK:55] = 00:00:52. 3345
R
I | I
(00:00; 23. 5000 00:04:17.0000
kin Time taw Time

@ Stop 6 Fail 0 Pazz |~ — Pazz Buttan

The window uses the comment text for the Transient Prompt Message and
shows the transient progress. Stopping a transient before the min time is reached
will stop the test. Test Engineer must press the Pass button before the max time
is reached, otherwise the test will stop. If Test Engineer only enter a max time
limit, the transient step will pass when Max Time is reached and the test will
proceed to the next step.

The title bar of the window shows the step number and test sequence file name.

If the test sequence is part of a test plan, the test plan step number and file name
are shown first.

Test Plan Step Humber Test Plan File Mame

# Step 3.2 - Transient [Sample Plan] [Sample Test] E|E|E|

Test Sequence Step Murmber Test Sequence File Name
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6.2 Timer

The Timer step inserts a delay in the test sequence. The Timer step design
window is shown below.

Dbiective] Preferences  Step Yalue/Comment lStep Result

Step 1 - I Timer
HOURS : MIN : SECONDS

Time Cartrols — 1] il |2—:| [a0 :I—

— Time
r Comment
Camment: [Allow LUT ta sete —
Et:;n gztotlgr?r Idle Step Total Elapsed Remaining
P | Taf 10 00:02:30.0000 | 00:00:00.0000 0002300000
e @ 10 00:02:30.0000 | 00.00:00.0000  00:02:30.0000
Step Description Yalue Comment Result
Step Table — 1 E Timer 0000:02:30 Allow UUT to zettle

Use the Time Controls to enter the desired delay time. The SECONDS value can
be entered in SS.SSSS format. The time value is also shown in the value column
of the step table. When a test sequence runs a Timer step, the progress/time
indicators update. Pressing the Stop Button in the Run Toolbar stops the test
with "Stopped"” results. When the Timer step is allowed to complete the test
sequence proceeds with the next step.

The text Test Engineer enter in the Comment box automatically appears in the
step table and test report.
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6.3 User Prompt

The User Prompt step allows the test sequence to ask the user to perform some
task such as verifying UUT operation or changing the test configuration. Shown
below is the User Prompt design window.

Dbiective] Preferences  Step Valus/Comment ‘Step Result

Step 1 - @ User Prompt

Message. .
Contest fyea ——
Load. ..
Contest Meru — 5500
r Comment Goka. ..
Comment; |Eheu:k operating state —
SH tL;n Ezﬁlgﬁr Idle Step Total Elapsed Remaining
F | 1of1: 0 00:00:00.0000 | 00:00:00.0000  00:00:00.0000
[ e E 1 00:00:00.0000 | 00:00:00.0000  00:00:00.0000
Step Descrniption Value Comment Result
Step Table — 1 @ Llzer Prompt Mezsage. . Check operating state

The context area contains the message text displayed to the user when the step
runs. Test Engineer can type directly into the context area or copy and paste text
or graphics from another application. Right-clicking the context area displays the
Context Menu. Test Engineer can Load or Save text from a Rich Text (*.rtf) or
Plain Text (*.txt) file. Go-to... shows the current cursor location and allows Test
Engineer to position the cursor to a particular line and column.

The text Test Engineer enter in the Comment box automatically appears in the
step table and test report.
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6.3.1 User Prompt Window

When the test sequence runs a user prompt step, the user prompt window
appears as shown below.

Pressing the Pass button causes the test sequence to proceed with the next
step. Pressing the Fail button stops the test with "Failed" results. Pressing the
Stop button (similar to pressing the Stop button in the Run Toolbar) stops the
test with "Stopped" results.

6.4 User Input

The User Input step allows the test sequence to ask the user to enter one or
more values. Shown below is the User Input design window. The Preamble is
the message displayed at the top of the User Input window to provide instructions

to the user.

Dbiectivel Preferences  Step Yalus/Comment l Step Hesult]

Step 1 -= User Input

Preamble — Preamble: |Enter values for the following iterms:
# Prompt Type Initial ¥alue °#¥ Report Field
1| Customer [abl Tewtbox CUSTOMER
Input Table —| 2| Repair [¥ Checkbax Off REPAIR
3| Technician Liztbox Dan TECHHICIAM
Right-click "#" colurn in table to addfremaove iten. Drag "#" column to rearder raws. Urd fl. A Field
Test Report — @ Report Template: Certificate ndefined Fiel
Template — Carment
Cornrment; |Get Info —
g‘tl;n TB?‘?:E:' Idle Step Total Elapsed HRemaining
" 1 Tof 11 00:00:00.0000 | 00:00:00.0000  00:00:00.0000
2 & | ¥ 1 )8 00:00:00.0000 | 00:00:00.0000  00:00:00.0000
Step Description Value Comment Result
Step Table — 1 Usger [nput Technician Customer Fepair Get Info
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6.4.1 Input Table

The input table contains the items Test Engineer want the user to supply when
the step runs. To add or delete items (rows), right-click in the step column (#) and
the input table context menu appears as shown below. New rows are added after
the row Test Engineer clicked the mouse. To add a row at the beginning, right-
click the table header. To add a row at the end, right-click the last row. To
rearrange rows, click the row in the step column (#) and drag it to the new
position.
Add

Impork
Export

The Prompt column is the title or brief description of the input row. The Type
column shows the input type. Clicking the type column for a particular row
displays the Input Type menu.

Texthox -

E-:u:-c :
.Listbn:-c

There are three different input types. TextBox is a simple text entry value.
CheckBox is an On/Off value and ListBox is a menu that lets the user select from
a list of choices. The Initial Value column lets Test Engineer specify the initial
value (TextBox text, CheckBox state and ListBox selection) that is shown when
the user input step runs. To create a list for a ListBox, enter the text for the first
item then press the Enter key. Repeat these steps for each additional item, and
then select the desired item Test Engineer want as the initial choice. To remove
an item from the list, first select the item then press the Delete key. Test
Engineer can also use the Delete key to remove the initial value for a TextBox
item.

Report Field allows users to select the form field related to the template files to
store the information input. When a test sequence runs, the test report file is
updated with the results. Test reports are based on template files created by MS
Word. The template file used by the test report window is shown in the design
window (top of this page) below the input table next to the report icon. Clicking
this icon activates the test report window. Refer to the Test Report topic for more
information on creating and selecting test report templates.

38



6.4.1 Input Table ( Cont.)

If the template file contains form fields, clicking the Report Field column in the input
table will display a menu that allows Test Engineer to select the form field to store
the information input by the user. Items in red mean that field is Undefined in the
selected template file. Either the wrong template file is selected or the file was
changed and this field no longer exists. To remove a form field for a row, click the
report column for that row then press the Delete key.

|CUSTOMER = |

6.4.2 User Input Window

When the test sequence runs a user input step, the user input window appears as
shown below.

The Preamble and Input Table show the values from the design window. The input
table is automatically filled in with initial values (including items and selection for the
ListBox) if specified. Clicking a Checkbox toggles the checkbox state. Note that the
Report Field column is not shown. This is because the value input by the user is
automatically stored in the report field (if any) specified in the design window.
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6.4.2 User Input Window ( Cont.)

After the user enters the values, pressing the Pass button causes the test sequence
to proceed with the next step. Pressing the Fail button stops the test with "Failed"
results. Pressing the Stop button (similar to pressing the Stop button in the Run
Toolbar) stops the test with "Stopped” results. In all three cases, the values entered
by the user are stored in the test report.The title bar of the

window shows the step number and test sequence file name. If the test sequence is
part of a test plan, the test plan step number and file name are shown first.

Test Plan Step Mumber Test Plan File Mame

g&f Step 3.1 - User Input [Sample Plan] [Sample Test] E@E|

Test Sequence Step Mumber Test Sequence File Mame

6.5 Meter

The Meter step allows the test sequence to measure voltage, current, power,
frequency, harmonics and waveforms using the built-in metering functions in Test
Engineerr UPC. These functions are normally performed manually using the UPC
Meter Window. The meter step also supports limit checking, out-of-limit behavior and
data logging.

When a test sequence runs a Meter step, the requested measurements are made,
updating the progress/time indicators and step result with the measured values. If
specified, limit checking is also performed on the measured values. If Test Engineer
specify that the test should fail if a value is outside the limits, the test will stop with
"Failed" results. Pressing the Stop Button in the Run Toolbar stops the test with
"Stopped" results. When the Meter step is allowed to complete, the test sequence
proceeds with the next step.

39



6.5 Meter ( Cont.)

The Meter step setup window is shown below.

Objective ] Preferences  StepValue/Comment l Step Result l— Meazurement Resultz

Step 1 -/~ Meter Output Form

Lirnit Action Menu

[rata Log Controls

|
Meter Type —Type:|V,|,F, Power j Folm:|3 j If Outside Linits; |Fail j Samples:|5 Intewal:|'| Sec (approx)
Menu | |
Phase Vims Irms
b eter <120500 <6500 ]—Limits Timne |
Function/Lirnits >113.500
Table B < B.A00
; I easure
Checkbox
C <6500 — Comment
Comment: |Check Valts and Amps —]
Hslt"; TBDUDJEJE: Idle Step Total Elapsed Remaining
P | Tof 10 00:00:04.0000 | 0C:00:00.0000 00003040000
| 3ES & ¥ 10 L00:00:04.0000 | 00:00:00.0000  00:0C:04.0000
Step ~ Description Yalue Comment Result
Step Table — 1 /) Meter s, s Check Yalts and Amps

Meter Type Menu selects which measurement category Test Engineer want to use.

The choices are shown below.

Meter Type  Available Functions Limit .
hecking

V.I.F,Power Vrms, Vrms(L-L), Irms, Ipeak, Icrest, KW, KVA, PF, Freq, Yes
Degrees

Volts Harm % THD, OHD, EHD, Magnitude (1-51), Phase (1-51) Yes

;;)mps Harm 15 OHD, EHD, Magnitude (1-51), Phase (1-51) Yes

Volts Harm ,

Abs THD, OHD, EHD, Magnitude (1-51), Phase (1-51) Yes

ﬁ[)“sps Harm b, OHD, EHD, Magnitude (1-51), Phase (1-51) Yes

Waveform Volts, Amps No

Data Log

Yes
Yes

Yes

Yes

Yes

No

When using “Waveform” in the Meter Type menu, the actual voltage and current
waveforms for each selected phase (1 cycle) are plotted in a graph and stored in the

Step Result tab and test report.
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6.5 Meter ( Cont.)

Output Form d specifies the data format of the metered data. An error occurs if the
present UPC output form (set by a previous Steady State step) does not match this
setting when the meter step is run.

Meter Function/Limits Table allows Test Engineer to specify which functions are
measured and any limit checking Test Engineer want performed. To add a function
to the table, right-click the header of the table and the Meter Function menu
appears. Shown below are the V, I, F, Power and Harmonics meter function menus.

Wl F. Power Harmonics
Delete DEL WrmsiL-L) Delete DEL COHD
EHD

Ipeak. Magnitude # Harrmonic 1
Icrest Phase L4 Harmonic 2
ki Harmonic 3
kNS Harmonic <
PF :
Freq Harrnonic 50
Degrees Harmonic 51

Items already in the table are disabled (grayed). The new item is added after the
column Test Engineer clicked the mouse. Test Engineer can rearrange columns by
click the table header for that column and dragging it to the new location. To delete a
column (function), click the mouse in the column header then press Delete. The
order the columns appear in the table is also the order the measurement appears in
the Step Result tab and test report.

For maximum performance, include only the meter functions and phases Test
Engineer need. Un-checking the Measure Checkbox allows Test Engineer to skip
that function/phase from being measured. When metering output form 2, the Vrms(L-
L) function should be used instead of Vrms.. Each measured value can be checked
against none, one or two limit values. This allows high/low range checking for each
measured value. Limit entries can use any of the following relational operators
followed by a number.

Operator The measured value must be...
> Greater than

>= Greater than or equal to

< Less than

<= Less than or equal to

= Equal to

<> Not equal to
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6.5 Meter ( Cont.)

Limit Action Menu controls what happens if a measured value is outside the limits.
“Continue” means the meter step completes normally. “Fail ” means the meter step
stops the test with "Failed" results. In either case, the out-of-limit measured value is
highlighted in red in the Step Result tab and test report.

Data Log Controls specify the number of measurement Samples and time Interval
between measurements. Data logging allows Test Engineer to monitor values over
an extended period of time. When making multiple measurements, the total time the
meter step takes is (Samples - 1) * Interval. The first measurement is taken
immediately when the meter step starts running. The meter step completes
immediately after the last measurement is made (no final delay). Specifying short
time intervals between measurements may not be achievable with Test Engineerr
power source or PC. The Step Result tab and test report shows the actual elapsed
time of each measurement and is highlighted in red if it didn't achieve the interval
Test Engineer specified. The progress/time indicators update as the step runs and
the Step

Result tab lets Test Engineer view measurements as they are being made. Data log
measurement samples are stored in separate rows as shown below.

Date/Time Elapzed Yims[L-N]JA ¥Y¥mms[L-N]JB ¥mms[L-N]JC Ims A Irms B Irms C
07/24/2007 095754 O 120120 120,051 120,033 6.483 £.481 6.470
07/24/2007 095754 0.500 120,104 120.058 120,023 6.484 £.480 6.470
07/24/2007 095755 1.000 120117 120.076 120.036 6.484 £.480 6.470
07242007 095755 1.604 120102 120.065 120,027 6.484 £.481 6.470
07/24/2007 05706 2104 120.098 120073 120.038 B.484 £.480 E.F'i53
Time Interval Outside Limit
Mot Achieved
Notes:

e When requesting a single sample, each phase uses a separate row in the
step result and test report, similar to the laTest Engineert of the Meter
Function Table in the meter design window.

e Setting Local Keyboard Lock (local lockout) ON and CSC Off improves
metering performance.
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6.6 Control Step

The Control step allows the test sequence to change UPC setup parameters like
CSC, Output Enable, and Transition Time etc. These items are normally defined in
the Setup panel in the UPC Control window in UPC Studio. User also is able to
create and change Control Step setup in UPC Test Manager under Step Value/

comment tab as shown below

"oltage and Frequency Limits

Db\ective] Freferences  Step Value/Camment lStep Hesult]

Step 1 - £ Control

Item Value «A Right-click table to add/remave item. Drag "ltem” column to reorder raws.
Cantral Table Transition Tirme! 01000 5 Changing this item may temporarily disable the autput,
5 FrogZo State| On
Output
Warming
r Comment
Comment; \Hamp Mode and ProgZo —
Idle Step Total Elapsed Remaining
Tof1: 0 00:00:00.0000 | 0C:00:00.0000  00:00:00.0000
[ JH @ & T 00:00:00.0000 | 000000000 00:00:00.0000
Step Description Yalue Comment Result
Step Table — 1) Contal Trangition Time,ProgZa State R amp Mode and ProgZo

The Control Table contains entries that change UPC setup values. To change an

existing entry, click in the value column for that row.

To add a new item in the Control Table,

e Right-click anywhere in the table to activate the Control Menu as shown

below.

Out e

Delete DEL CaC
Eeep
ProgZo State
ProgZo Ohms
Initial Yaltage
Wolk Sense
Range Control
Frequency Span
Transitian Time
Current Proteck
Local Lockout
Kevboard Lock
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6.6 Control Step ( Cont.)

The items in the menu vary depending on the features supported by Test Engineerr
power source. Items already in the table are disabled (grayed). Selecting one of
these items adds it to the table. The new item is added after the row Test Engineer
right-clicked the mouse. To add an item at the beginning, right-click the Item column
in the table header. To add an item at the end, right-click the Item column of the last
row. The order of the items in the table is not critical but Test Engineer can
rearrange them by clicking the item column for a row and dragging it to the new
location. To delete a row, click the item column for that row then press the Delete
key.

The text Test Engineer enter in the Comment box automatically appears in the step
table and test report.

Notes:

e The Steady State and Transient test steps automatically enable the output
and select the optimum frequency span so it's not necessary to add a control
step to do this.

e Depending on Test Engineerr UPC model, changing some items may
temporarily disable the output. These items are marked with the Output
Warning icon .

e The Output Enable value may actually change first or last depending on
whether it's being enable or disabled and the other items and values in the
control table that Test Engineer specified.

e Avoid using multiple control steps back-to-back to only change one item.
Changing all needed items in one step reduces output enable changes and
speeds up the test.

e Only include items that need changing. Including unnecessary items slows
down the test and may unintentionally change a value set by another step. To
delete a row, click the item column for that row then press the Delete key.

e The voltage and frequency limit values can only be set in the test sequence
Preferences tab.

e The control table does not allow changing the hardware configuration
(Transformer Ratio, Amps Volts Ratio, CT Location, Amplifiers).

e The value of the Beep item controls the UPC beep duration
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6.7 VISA

The VISA step allows the test sequence to perform generic instrument control and
monitoring. It's primarily designed for use with instruments that support message
based communication using the SCPI standard. The VISA step design window is

shown below.

Dhiective] Freferences  Step Yalue/Comment ] Step Result l— Inztrument Response

Step 1-_ 9 VISA
Resource Value Read Write VYalue
Hes%urhcle — Interface| GFIB Timeout [mzec) 5000
e GFIB Board Temination Char| 10
Frimary Address | 1 Send EMD [wiite] Tes
Secondany Address Suppresz EMD [Read) Mo
Command | *IDN?
ReadAwiite Flesponze| Read
Table
r Comment
Comment: | Get Device 10 and Serial Number —
Idle Step Total Elapsed Remaining
Tof1: 1 00:00:00.0000 | 00:00:00,0000  00:00:00.0000
| e & 3 1 00:00:00.0000 | 00:00:00.0000  00:00:00.0000
Step Description Yalue Comment Result
Step Table — 1.5 vI5a GPIE: 1:IM5TR DM Get Device |0 and Serial Mumber

The Resource Table defines the interface settings used to connect to the instrument.
The items shown in the resource table vary depending on the interface type Test
Engineer select. Clicking the "Interface" value column displays the Interface Menu.

GFIE

j

GFIB-4=
RSIE
SERIAL
TCRIF
LSE

il
ALIAS
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6.7 VISA ( Cont.)

The Interface menu lets Test Engineer select from a list of hardware interfaces. Test
Engineer can use Measurement & Automation Explorer (MAX) available from
National Instruments to view, test and configure the installed hardware and software
interfaces on Test Engineerr PC. Note that some items in the resource table are
optional and can be left blank.

The Read/Write Table defines the communication settings to use with the
instrument. The "Timeout (msec)"value is the maximum time the VISA step will wait
for the instrument to complete the command or provide the response. The
"Command" value is the command to send to the instrument. If the instrument
command generates a response, choose "Read" for the response otherwise choose
"None". The response is shown in the Step Result tab and included in the test
report.

The text Test Engineer enter in the Comment box automatically appears in the step
table and test report.
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6.8 Script

The Script step allows the test sequence to perform custom operations using
Microsoft Visual Basic Scripting. In addition to the full VBScript language support,
the script has access to various test manager objects. Scripts are very fast and
efficient and run without needing a compiler or other programming tools. The Script
step design window is shown below.

Dbiectivel Preferences  Step Value/Camment IStepHesuItl
Step 1- € Script

Test Manager Script Starter Code
Public Const kScrptTime = 0

Script ——{Public Cangt kTimeOut = 10 e,
i Context Menu —  Gato...
Timeout [Sec) Sub Scrpiban] ontext Menu ok
T RtProgress. SelTest = "Hello Warld"
Code ——

Window IF [TM.FurEnCode <> TM RunCadeFiun) Then Exit Sub
TM.RurErnCade = TH.RunCadeDaone
TH.RurEnD ate = How

End Sub Comrment
Comment; |"He||c| World" Dema —
E?Dn Tﬂltzir Idle Step Total Elapsed Remaining
P | Taf1:0 0000000000 | 0000000000 00:00:00.0000
» 2 @ [ 1 00:00:00.0000 | 00:00:00.0000  00:00:00.0000
Step Description Yalue Comment Result
Step Table — 1 $Script "Test Manager Script Starter Code "Hella \Warld" Demo

The above example shows the default script created when Test Engineer add a new
Script step to the step table. The script starter code simply puts "Hello World!" in the
Step Result tab and test report. Test Engineer can enter or edit code directly in the
Code Window and immediately run it using the Run Toolbar. Running a script step
calls the Script Main subroutine.

The first line of the script (usually a comment) appears in the value column of the
step table. Two optional constants at the top of the code window define time
information (seconds) used by the test sequence prior to running the script.
kScriptTime is the step time estimate used for the progress/time indicators and
kTimeOut is the maximum time the script should be allowed exclusive control Test
Engineerr PC before a message box is displayed asking if Test Engineer want to
cancel the script
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6.8.1 Test Manager Object Reference

This section defines the various methods and properties available to a script. Test
manager objects begin with "TM".

Notes:

e The range for program numbers is 0-99, where 0 refers to the Manual Mode
program.

e Script coding errors (syntax and run-time) are reported in the Step Result tab.

e Use Go-to ... in the Context Menu to view the current cursor location or locate
a particular line and column.

e Scripts can use the Step object to read but not change the values and result
of any step in the Step Table.

e When a script starts, the prior results are automatically cleared. Test Engineer
can use form fields in the test report to simulate "global” variables or to pass
values between script steps.

e To assist troubleshooting and debugging, use TM.RunMsgBox and
TM.RunInputBox to show or enter variables.

e Do not use TM.RunVisa to change values of Test Engineerr power source.
Instead, use the methods and properties provided by the Run and UPC
objects.

e Creating and debugging scripts require prior programming experience with
VBScript. Contact Pacific Power for assistance in developing custom scripts.

e The property Get and Let definitions listed below should be treated as
variable assignments (e.g. result = TM.RunErrCode or TM.RunStepProgress
=1t) in Test Engineerr script code.
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6.8.2 Run Object

Public Property Get TM.RunStep () As Integer
Returns the step number currently running (the script step).
Public Property Get TM.RunNextStep () As Integer

Returns the step number that will be run after the script step completes. The default
value is 0 which means to run the next step.

Public Property Let TM.RunNextStep (ByVal step As Integer)

Sets the step number to be run after the script step completes. The default value is 0
which means to run the next step. Changing the next step is essentially the same as
a "Go-to". Be careful when changing TM.RunNextStep because it makes the test
difficult to analyze and can create endless loop situations.

Public Property Get TM.StepElapsedTime () As Double

Returns the elapsed time in seconds since the script step started.

Public Property Let TM.RunStepProgress (ByVal elapsed As Double)

Updates the progress and time indicators with "elapsed” time

Public Property Get TM.RunStepPercent () As Single

Returns the step percentage completed.

Public Property Let TM.RunStepPercent (ByVal percent As Single)

Updates the progress and time indicator with the "percent" complete. Only applies if
kScriptTime = 0.

Public Sub TM.RunDoEvents ()

Gives the test manager time to update (not normally necessary).
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6.8.2 Run Object ( Cont.)

Public Function TM.RunUserPrompt (ByVal Caption as String, ByVal prompt
As String) As Integer

Displays a User Prompt window. Refer to the TM.RunCodeXXX properties for the
return values. "Caption" is the title bar of the window and "prompt" can be Rich or
Plain Text.

Public Function TM.RunUserinput (ByVal Caption As String, ByVal parameter
As String, result As Variant) As Integer

Displays a User Input window. Refer to the TM.RunCodeXXX properties for the
return values. "Caption" is the title bar of the window and "parameter" is a formatted
string that defines the input table rows and columns. "Result" is a string containing
the values input by the user. Refer to the TM.ReportinputXXX properties for
constants that define the various input types (Textbox, Checkbox, and Listbox). The
easiest way to determine the “parameter” string format is to create a user input step
and export it to a file then examine the files contents.

Public Function TM.RunControl (ByVal param As String) As String

Updates UPC setup values. The easiest way to determine the “param” string is to
create a Control step and export it to a file then examine the file contents. The return
value is the query response string.

Public Function TM.RunVisa (ByVal param As String) As String

Sends a command string to an instrument and return the response.The easiest way
to determine the "param" string is to create a Visa step and export it to a file then
examine the file contents. Test Engineer only need to include values that relate to
the interface (resource) Test Engineer are using. If the "command" uses commas,
Test Engineer must replace them with TM.VisaCommaChar. The comma will be
restored when the VISA step runs.

Public Function TM.RunProgramDefine(ByVal progNum As Integer, ByVal field As
String, ByVal data As String, Optional ByVal prefix As String) As Boolean
Sends a program define string to the UPC. Test Engineer can send a single "field"
with "data" or group multiple fields together. When updating multiple fields, the "field"
contains comma delimited field and data pairs except skip the final comma and data
value. Then set the "data" value to the data for the last field. Refer to the UPC
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Operation Manual for the available program define fields and data values. Returns
True if the program define was sent successfully.

6.8.2 Run Object ( Cont.)

Public Function TM.RunProgram (ByVal progNum As Integer) As Boolean
Executes a program. Return False if the program is not stored.

Public Function TM.RunTransient () As Boolean

Triggers a transient. Returns True when the transient completes.

Public Sub TM.RunErrClear ()

Clears the test manager error state. This is normally used when the script uses "On
Error Resume Next "and Test Engineer want to handle errors and continue.

Public Property Get TM.RunErrCode () As Integer

Returns the current error code. Refer to the TM.RunCodeXXX properties for the
return values. This property allows Test Engineer to determine if the test manager
has generated an error.

Public Property Let TM.RunErrCode (ByVal errCode As Integer)

Sets the error code. Refer to the TM.RunCodeXXX properties for the available
values.

Public Property Get TM.RunErrDate () As Date

Returns the date and time the error reported by TM.RunErrCode occurred.
Public Property Let TM.RunErrDate (ByVal errDate As Date)

Sets the data and time the error occurred.

Public Property Get TM.RunErrDesc () As String

Returns a description of the error reported by TM.RunErrCode.

Public Property Let TM.RunErrDesc (ByVal errDesc As String)
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Sets the description of the error.

6.8.3 Run Object ( Cont.)

Public Property Get TM.RunCodeRun () As Integer

Returns the value for the "Running” state. This is the normal state of a step when it's
running.

Public Property Get TM.RunCodeStop () As Integer
Returns the value for the "Stopped" state. This is the state when a step is stopped.
Public Property Get TM.RunCodeDone () As Integer

Returns the value for the "Done" state ("Passed"). This is the state when a step has
completed normally.

Public Property Get TM.RunCodeFailed () As Integer
Returns the value for the "Failed" state. This is the state when a step has failed.
Public Property Get TM.RunCodeSkipped () As Integer

Returns the value for the "Skipped" state. This is the state when the test sequence
attempts to run a step and the enable checkbox is not checked.

Public Function TM.RunMsgBox (ByVal prompt As String, Optional ByVal flags
As Long = vbOKOnly, Optional ByVal title As String ="VBScript") as integer

Calls the standard Visual Basic MsgBox function modally in the test manager
workspace.

Public Function TM.RuninputBox (ByVal prompt As String, Optional ByVal title
As String = "VBScript") as integer

Calls the standard Visual Basic InputBox function modally in the test manager
workspace.
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6.8.3 Step Object

Public Property Get TM.StepEnabled (ByVal i As Integer) As Boolean
Returns the enable checkbox state of the requested step.

Public Property Get TM.StepType (ByVal i As Integer) As Integer
Returns the numeric index of the type of the requested step.

Public Property Get TM.StepDesc (ByVal i As Integer) As String
Returns the description of the requested step.

Public Property Get TM.StepComment (ByVal i As Integer) As String
Returns the comment of the requested step.

Public Property Get TM.StepSeconds (ByVal i As Integer) As Single
Returns the time estimate of the requested step.

Public Property Get TM.Steplinvalid (ByVal i As Integer) As Boolean
Returns True if the requested step contains invalid values.

Public Property Get TM.StepSummary (ByVal i As Integer) As String
Returns the text summary for the values of the requested step.

Public Property Get TM.StepParameter (ByVal i As Integer) As String
Returns the parameter value of the requested step.

Public Property Get TM.StepCount () As Integer

Returns the total number of steps in the test sequence.

Public Property Get TM.StepResultCode (ByVal i As Integer) As Integer
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Returns the result code of the requested step. Refer to the TM.RunCodeXXX
properties for the available values.

6.8.3 Step Object (Cont.)

Public Property Get TM.StepResultDate (ByVal i As Integer) As Date
Returns the date and time the requested step completed.

Public Property Get TM.StepResultElapsed (ByVal i As Integer) As Single
Returns the elapsed time in seconds the requested step took to complete.
Public Property Get TM.StepResultTitle (ByVal i As Integer) As String

Returns the result title (Passed, Stopped, Failed, and Skipped) of the requested
step.

Public Property Get TM.StepResultRtf (ByVal i As Integer) As String
Returns a Rich Text string of the result data for the requested step.

Public Property Get TM.StepResultSelected (ByVal i As Integer) As Boolean
Returns True if the Result tab for requested step is currently selected.

Public Property Get TM.StepReportFlags (ByVal i As Integer) As Integer

Returns the report flags of the requested step. Refer to the TM.ReportStepXXX
properties for the available flags.

Public Property Let TM.StepReportFlags (ByVal i As Integer, ByVal report As
Integer)

Sets the report flags of the requested step. Refer to the TM.ReportStepXXX

properties for the available flags. To include multiple items, add them together (i. e.
TM.ReportStepTitle + TM.ReportStepResultTitle + TM.ReportStepResultData)
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6.8.4 Report Object

Public Sub TM.ReportGetinfo (path As Variant, fileDirty As Variant, template
As Variant)

Sets "path" to the current report file path. Sets "fileDirty" to True if the file has been
changed but not saved. Sets "template” to the current template name.

Public Function TM.ReportSave (ByVal path As String) As Boolean

Saves the test report to the file specified by "path". Returns True if the file was
successfully saved.

Public Function TM.ReportGetTemplate (ByVal Index As Integer, name As
Variant) As Boolean

Sets "name" to the template name of the specified index. This function allows Test
Engineer to query the available templates. Start with an index of 0 and continue until
the function returns False.

Public Function TM.ReportSetTemplate (ByVal name As String) As Boolean

Changes the report template to "name". This also clears the test report. Returns
True if the template name exists and the report was initialized.

Public Function TM.ReportGetFieldinfo (ByVal Index As Integer, name As
Variant, checkboxfield As Variant) As Boolean

Returns information about the form fields in the test report. Sets "name" to the field
name. Sets "checkbox" to True if the field is a checkbox. This function allows Test
Engineer to query the available form fields in the current test report. Start with an
index of 0 and continue until the function returns False.

Public Function TM.ReportGetField (ByVal name As String, Val As Variant,
ByVal checkbox field As Boolean) As Boolean

Sets "Val" to the value of the form field specified by "name". Sets "checkbox field" to

True if the field is a checkbox. Returns False if the requested field name does not
exist in the test report.
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6.8.4 Report Object ( Cont.)

Public Function TM.ReportSetField (ByVal name As String, ByVal val As
String, ByVal checkboxfield As Boolean) As Boolean

Sets the form field specified by "name" to "val'. Test Engineer must set
"checkboxfield" to True if the field type is a checkbox. Returns False if the requested
field name does not exist or the checkbox field value does not match the actual field
type in the report.

Public Property Get TM.ReportStepTitle () As Integer

Returns a constant that controls if the step title is included in the test report. See
StepReportFlags above.

Public Property Get TM.ReportStepSummary () As Integer

Returns a constant that controls if the step summary is included in the test report.
See StepReportFlags above.

Public Property Get TM.ReportStepComment () As Integer

Returns a constant that controls if the step comment is included in the test report.
See StepReportFlags above.

Public Property Get TM.ReportStepResultTitle () As Integer

Returns a constant that controls if the step result title is included in the test report.
See StepReportFlags above.

Public Property Get TM.ReportStepResultData () As Integer

Returns a constant that controls if the step result data is included in the test report.
See StepReportFlags above.

Public Property Get TM.ReportStepAll () As Integer

Returns a constant that controls if the all step items are included in the test report.
See StepReportFlags above.
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Public Property Get TM.ReportRtfClear () As String

Returns a string that can be used to reset formatting and clear text in a RichTextBox.

6.8.4 Report Object ( Cont.)

Public Property Get TM.ReportGraphWidth () As Long

Returns the width in pixels of the waveform graph created by the Meter step.
Public Property Let TM.ReportGraphWidth (ByVal Width As Long)

Sets the width in pixels of the waveform graph created by the Meter step.
Public Property Get TM.ReportGraphHeight () As Long

Returns the height in pixels of the waveform graph created by the Meter step.
Public Property Let TM.ReportGraphHeight (ByVal Height As Long)
Sets the height in pixels of the waveform graph created by the Meter step.
Public Property Get TM.ReportinputTextbox () As Long

Returns a constant that defines the Textbox type used for the TM.RunUserinput
function "parameter”.

Public Property Get TM.ReportinputCheckbox () As Long

Returns a constant that defines the Checkbox type used for the TM.RunUserIinput
function "parameter”.

Public Property Get TM.ReportinputListbox () As Long

Returns a constant that defines the Listbox type used for the TM.RunUserlinput
function "parameter".
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6.8.5 UPC Object

Public Function TM.UpcGetProgramNameCRC (ByVal progNum As Integer,
name As Variant, crc As Variant) As Boolean

Sets "name” to the output sequence file name and "crc" to the program CRC for the
specified program. Returns False is no program is stored at "progNum".

Public Function TM.UpcGetExecutingProgram () As Integer

Returns the currently executing program number.0O is the Manual Mode program and
-1 means no program is currently executing.

Public Property Get TM.UpcGetinfo () As String

Returns info about the UPC Test Engineer are currently connected (IDN, serial
number, supported features etc).

Public Property Get TM.UpcGetSetup () As String

Returns the setup and configuration values of the UPC.

Public Property Get TM.UpcGetProgram (ByVal progNum As Integer) As String
Returns the program values (Steady State and Transient) of the requested program.
Public Property Get TM.UpcGetkFactors () As String

Returns the kFactors calibration data of the UPC.

Public Property Get TM.UpcGetProgZoCal () As String

Returns the ProgZo calibration data of the UPC.

Public Function TM.UpcGetWaveform(ByVal wf As Integer, title As Variant,

source As Variant, dateTime As Variant, comments As Variant, crc As Variant,
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maxVrms As Variant, rmsFactor As Variant, dcOffset As Variant, data As
Variant) As Boolean

Returns waveform values of waveform "wf". "data" is set to an array of 1024 values
ranging from -100 to +100 percent. The waveform values are shown in the
Waveform Editor window.

6.8.5 UPC Object ( Cont.)

Public Function TM.UpcSetWaveform(ByVal wf As Integer, title As Variant,
source As Variant, dateTime As Variant, comments As Variant, data As
Variant) As Boolean

Sets the values for waveform "wf". "data" is an array of 1024 values ranging from -
100 to +100 percent. The waveform values are shown in the Waveform Editor
window.

For maximum performance and to reduce memory usage, it's best to set "source” to
TM.UpcWaveformNoDatabase to prevent the waveform from being added to the
waveform reference database. It's also recommended Test Engineer restore any
waveforms Test Engineer change back to a sine wave. To restore a waveform to a
sine wave, use TM.UpcGetWaveform (1 ...) to read waveform 1 (it's always a sine
wave) then use TM.UpcSetWaveform to reset it.

Note: TM.UpcSetWaveform disables the output.

Public Function TM.UpcGetEvents () As String

Returns a string of event tokens currently showing the Event Status Panel. The
tokens (description) are "CAPTURE" (probe capture), "ERR" (Error), "PON" (power
on), "SHUTDOWN" (power source shutdown), "URQ" (user request), "IPROT"
(current protect), "VPROT" (voltage protect), "NR" (remote interface not responding)
and "BSY" (remote interface busy).

Public Sub TM.UpcClearEvents ()

Resets all events in the Event Status Panel.
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6.8.6 Rich Textbox Objects

Scripts have access to three rich textbox objects. These are standard Visual Basic
RichTextBox controls. Refer to the Microsoft documentation for the available
properties and methods. These controls allow Test Engineer to create and
manipulate formatted text and graphics. Test Engineer can access these controls
using TM.RtfProgress, TM.RtfResults and TM.RtfTemp. The contents of
TM.RtfProgress are shown in the step result tab and test report when the script
completes. Use RtfTemp for a scratch pad but keep in mind that the contents may
be changed by other test manager objects. RtfResults allows Test Engineer to
dynamically update the step result tab (like the Meter step does during data logging)
while the script is running. Test Engineer should only update RtfResults if
TM.StepResultSelected returns True for Test Engineerr script step. To initialize the
contents of a rich textbox, use TM.RtfTemp.TextRTF = TM.ReportRtfClear.

6.9 Steady State

In additions to the step types listed in the Context Menu, user also can use Steady
State step to import a existing output sequence files into the UPC Test Manager to
set the power source output voltage, frequency, phase, and waveform, output form,
coupling and current limit.

Use Import... in the step table context menu to import output sequence files into the
step table. Output sequences contain steady state and optional transient values.
These appear as two separate rows in the Step Table linked together. Clicking on
the steady state step shows the values in the Context Area. Red text indicates
values outside the limits defined in the Preferences tab or values not supported by
Test Engineerr power source (i.e. Form or Coupling). Click the Preferences tab to
view and edit the limits. Note that the limits apply to all Steady State and Transient
steps in the test sequence. Test Engineer can delete the transient step if Test
Engineer only want the steady state values to be used in the test.
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The test sequence will not run steps that contain invalid values. When running a
steady state step, the test sequence stores the output sequence in one of the
programs Test Engineer specified in the program list in the Preferences tab. It then
executes the steady values and enables the output.

6.9 Steady State ( Cont.)

To edit the steady state values, double click the steady state step in the step table.
The output sequence window will appear allowing Test Engineer to make changes.
Click the Save button in the output sequence window toolbar to save the changes to
the test sequence. Test sequences store the actual contents of the output sequence
Test Engineer imported. This means changes to the Steady State or Transient steps
in the test sequence do not affect the original output sequence file.

The Context Menu allows Test Engineer to save the steady state values to a Rich
Text (*.rtf) or Plain Text (*.txt) file. The text Test Engineer enter in the Comment box
automatically appears in the step table and test report.

Preferences Tab —|

Dbiective] Preferences &b Step Valus/Comment lStep Result
Step 1 - > Steady State

Phasze Yolts Waveform Degiees
A 120.000000 1-Sine 1]
B 120.000000 1-5ine 120
120.000000 1-Sine 240
Context dreg ——
Form: 3 Coupling: DIRECT Contest Menu —  save |
Frequency: 60.000000 Current Limit: 13.333333 Amps ot
Tranzient; Time bazed, 2 segments ...
CRC: 31099
r Cormrment
Comment; |A|:||:|I_I,J nominal woltage —
Idle Step Total Elapsed Remaining
Tof2 00:00:08.0000 | 00:00:00.0000 0000080000
| ET & | ¥ 1o 00:00:00.0000 | 00:00:00.0000  00:00:00.0000
Step Description Value Comment Result
Step Table — 1 [} Steady State Wa=120.0%b=120.0%ec=120.0 F=60.0 Apply nominal voltage
2 Transient Infiite [2.0] Overvaltage Surges
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EXERCISE

7.1 Exercise 1: Creating a Test Plan

Assume Test Engineer have purchased DO160E Test Sequence option and
installed with Test Engineerr UPC Studio Test Manager. Test Engineer can use
Test Manager to quickly create a Test Plan which links together several existing
DO160E Test Sequences in a single test. In this exercise we are going to create a
Test Plan using multiple existing DO160E Test Sequences. In the UPC Studio
Window,

1. Click arrow button next to Test Manager icon and select New - Test Plan
as illustrated below to open a new Test Plan setup window.
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7.1 Exercise 1: Creating a Test Plan ( Cont.)

2. In Objective tab, enter the description as shown below.

3. Right-click anywhere in the Step table and select Add from the popup menu
as shown below
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7.1 Exercise 1: Creating a Test Plan ( Cont.)

4. Inthe Add Test Sequence window, select

DOE16511B_ACF_Voltage_Frequency_1 PH.tsq in the folder
C:\Pacific Power Source\UPC Manager\Test Manager\DO160E\ACF\Single Phase

as shown below. Click Open button.
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7.1 Exercise 1: Creating a Test Plan ( Cont.)

The test sequence DOE16511B ACF_Voltage Frequency 1 PH.tsg now is added
to the test plan. The objective of the selected test sequence is automatically loaded
as shown In the Objective tab

In the Step Info tab, the test sequence properties such as file path, last updated
time, number of steps in the test sequence and total run time are also recorded as

shown below.
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7.1 Exercise 1: Creating a Test Plan ( Cont.)

5. Repeat steps 3 and 4 to add second test sequence
DOE165182_ACF_Total Harmonic Distortion 1 PH.tsq to the test plan.
The file path is
C:\Pacific Power Source\UPC Manager\Test Manager\DO160E\ACF\Single
Phase\DOE165182_ ACF_Total Harmonic Distortion 1 PH.tsq

The test plan design window should look the same as illustrated below
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7.1 Exercise 1: Creating a Test Plan ( Cont.)

6. Setthe Preference properties as shown below

7. Click Save As button &y from the menu toolbar and save the test plan as
Exercisel.tpl
8. Click Start button I»_ from the run toolbar to run the test plan.
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7.1 Exercise 1: Creating a Test Plan ( Cont.)

9. Double click the step 1 to open the DOE16511B_ACF_Voltage Frequency_1
PH.tsq test progression window as shown below.

Notice in the Test Sequence window, unlike exercise one, each test sequence step
is numbered as 1.1, 1.2,.....1.23. This is because those test sequence steps are
also part of test plan being executed.
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7.1 Exercise 1: Creating a Test Plan ( Cont.)

To open the Test Report:

e Click Show Report button ¥ from the Run Toolbar to open
the test report window as shown below.

e Click Save As button g in the test report window and save the
report file as Exercisl_TR.rft

The test report of a Test Plan is saved in the following directory by default

C:\Pacific Power Source\UPC Manager\Test Reports\Templates
The directory can be change based on Test Engineerr preference.
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7.2 Exercise 2: Loading a Test Sequence

To launch the Test Manager in a simulation mode with UPC-32/12 firmware 5.2.0
version,

e Click Start > Programs - Pacific Power Source - UPC Manager from the
desktop to open the UPC Manager window

e Select Simulate tab, then click “133863 v520.mdb” option from the list as
shown below and click Connect button.

Note: The options appeared in the list are in the format of PPS UPC firmware part
number _ revision # In this example 133863 is PPS part number of the firmware
embedded in UPC-32/12 controller, and current revision is 5.2.0

e Click arrow button next to Test Manager icon and select the “Example Test
Sequence.tsq” from the dropdown menu as illustrated below
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Now the Example Test Sequence.tsq is loaded into Test Manager window.

7.3 Exercise 3: Creating and Executing a Test Sequence

Exercise 3 is to create a new test sequence that is a duplication of Example Test
Sequence.tsq in Exercise 2, as illustrated below, and then execute it.

7.3.1 Creating a Test Sequence

1. Click arrow button next to Test Manager icon and select New - Test
Sequence as illustrated below to open a new Test Sequence setup window.
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7.3.1 Creating a Test Sequence ( Cont.)

2. Click Objective tab and copy (Ctrl+C) and paste ( Ctrl+V) the following
paragraph including the picture into the Context area to define the objective of
the test sequence.

Sample Test Sequence

Test Sequences can be used to perform multiple tests without having to load programs on an
individual basis to the AC Power Source. A Test Sequence also allows the user to set up
User Prompts and request information about the test or Unit Under Test (UUT). This example
will demonstrate some of the common functions available with a Test Sequence.

The Objective is used to define what the Test Sequence is to accomplish or perform. In this
field Test Engineer can paste (Ctrl-V) pictures or text from other documents to print in Test
Engineerr report.

Once the step 2 is completed, the window should look same as shown below.
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7.3.1 Creating a Test Sequence ( Cont.)

3. Click Preference tab, and change the settings to be the same as shown
below.

O

Click Step Value/Comment tab,

Right-click anywhere in the step table area to active context menu
Select New - User Input from context menu to add user input step as
illustrated below.

o gk
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7.3.1 Creating a Test Sequence ( Cont.)

7. In the Comment field enter the text “Ask for information so it can be recorded
in the Test Report.” and then press Enter key.

The default setting for User Input step should be same as shown below. If
not, modify the settings accordingly.

8. Move the mouse to the header “Step” in the step table area, and right-click to
active the context menu.
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7.3.1 Creating a Test Sequence ( Cont.)

9. Select New = Control from the menu as shown below.

As illustrated below the Control step is added as step 1 right above User
Input. User Input step now becomes step 2.
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10. Right-click anywhere on the Control table in the context area

7.3.1 Creating a Test Sequence ( Cont.)

11. Select Add—> Output Enable from the menu to add Output Enable control as
shown below.

12. Set the Value of Output Enable to be “On” as shown below.
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13.Click anywhere in Step table and select Import from the context menu

7.3.1 Creating a Test Sequence ( Cont.)

14. In Import Test Step window choose the existing output sequence
Example - Voltage Drop.fm3 from the direction C:\Pacific Power Source\UPC
Manager\Output Sequences folder as shown below, and click Open button to
go back to Step Value/Comment tab in UPC Test Manager.

15. In the Comment field, modify the text to “Import Output Sequence file:
Example - Voltage Drop.fm3, 80% Voltage Drop for 0.5 Seconds”

16. Select step4 Transient; In the Comment field, enter the text “ Precision time
variation of power source output”, and press Enter key
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7.3.1 Creating a Test Sequence ( Cont.)

The new Step Value/Comment tab should look similar to the one shown below.

Note: Importing this output sequence not only adds step3, a steady state step, also
adds step4, a transient step to the table. The output sequence Example - Voltage
Drop.fm3 was created using UPC studio. Please refer to the UPC Studio Operation
manual on how to create output sequence.

17. Select step3 Steady State from the table.

18. Right-click and choose New—> Meter to insert a Meter step below Steady
State step as shown below
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7.3.1 Creating a Test Sequence ( Cont.)

19. Right click header “Irms” in the Meter table, and select Add-> PF to add a
Power Factor column after Irms column.
20. Right click header “PF” in the Meter table, and select Add-> Degrees to
add a
degrees column after PF column.
21. Right click header “PF” in the Meter table, and select Add-> Freq to insert a
frequency column before Degrees column.

The new window should be same to the following illustration.
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22.Select step5 Transient step, and right-click.
23.Choose New-> Timer to add step6, a Timer step.
24. Set Timer to be 0 hours, 1 minute, 0 second as shown below.

>

7.3.1 Creating a Test Sequence ( Cont.)
25. Select step6 Timer step, and right-click.
26. Choose New-> Transient to add step7, a Transient step.
27. In the Comment field, enter the text “Precision time variation of power
source output”, and press Enter key.

The Step Value / Comment window is shown below.
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28. Select step7 Timer step, and right-click.

29. Choose New-> User Prompt to add step8, a User Prompt step.

30. Inthe User Prompt message field, enter the text “Run a performance check
of the UUT”, and press Enter key.

7.3.1 Creating a Test Sequence ( Cont.)

31. Inthe Comment field, enter the text “Instruct the user to setup a UUT, make
measurement, or simply pause”, and press Enter key.

32.Select step8 and right click. Select Import from the context menu

33. In Import Test Step window choose the existing output sequence
Example - Waveform Substitution.fm1 from the direction C:\Pacific Power
Source\UPC Manager\Output Sequences folder as shown below, and click
Open button to go back to Step Value/Comment tab in UPC Test Manager.
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7.3.1 Creating a Test Sequence ( Cont.)

34.Select step9; in the Comment field, enter the text “Imported Output
Sequence file: Example - Waveform Substitution.fm1, Change the waveform
for 3 Cycles”, and press Enter key.

35. Select stepl0; in the Comment field, enter the text “Precision time variation
of power source output”, and press Enter key.

The window should be the same as shown below.

36. Select stepl0 Steady State from the table.
37. Right-click and choose New-> Meter to add stepll a Meter step
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38. Set the Meter property window the same as shown below.

——

~ >

7.3.1 Creating a Test Sequence ( Cont.)
39. Select stepll Steady State from the table.

40. Right-click and choose New-> Script to add stepl12 a Script step
41. Type VB script in the script window as shown below.
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Now a test sequence which consists of 12 output sequences has been created.

42.Click Save As button &gfrom the file menu bar to save the new test
sequence
43.Type a new name in the File name file: Exercise3.tsq

7.3.2 Executing a Test Sequence

44.Select step 1, Control step from the Step table and click Start button |p .
45. Enter then information as shown below in the popup window and then click
Pass button

As the test sequence simulation progressing, the test result (pass/fail ) for
each step is recorded result column in the step table as shown below.

84



When the step 8 User Prompt is in progress, the User Prompt window
indicated below pops up.

7.3.3 Executing a Test
Sequence ( Cont.)

46.Click Pass button to continue.

The simulation is interrupted because the step 11 Meter fails the test as
indicated below.

47.Select the step 11 and switch to Step Result tab to see error message as
shown below.

The following error message appeared in the
Step Result window.

Error:

UPC output Form (1) does not match
requested meter Form (3).
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48.Switch back to Step Value/Comment tab and change the Form settings from
3 to 1 as shown below to fix the error.

7.3.3 Executing a
Test Sequence ( Cont.)

49.Click Save button [ from the menu bar to save the change

50.Select step 11 from the step table and click Continue button |£| to continue
the simulation.

51.Click the Step Result tab after the test sequence simulation is finished.

The “Test is Completed!” appears in the Result text field as illustrated below.

52. Click Show Report button @ from the Run Toolbar to open the test report
window as shown below.
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7.3.4 Executing a Test Sequence ( Cont.)

Each test step and its test result including time, pass/fail, values and error message
are recorded in details as shown below.

53.Click Save As button Ig]j in the test report window and save the report file as
Exercise3_TR.rft

By default the test report is saved in the following directory

C:\Pacific Power Source\UPC Manager\Test Reports\Templates
The directory can be change based on Users’ preference.
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